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Brief introduction

The main purpose of this guide for beginners is to have basic knowledge of

Wordpress features and functionalities.

The guide is based on a ‘out-of-the-box’ installation of Wordpress, many of the
features that we will focus will always be present in any Wordpress website, even on

custom developed websites.

We will use support videos for each section, these videos were made by iThemes, a
company focused on plugins development for Wordpress, they have made some

fantastic videos that will help in this learning process.

These videos are practical and simple to understand and are up to date with the

latest versions of Wordpress.



Logging into your WordPress Site

Once WordPress has been setup, you can access your WordPress login page from
two different URLs.

W
>

Watch the video: Your WordPress Login

Your WordPress Login URL

The first way to access your WordPress Login URL will be in this format:

http://yoursite.com/wp-login.php

You can also log in from:

http://yoursite.com/wp-admin


https://vimeo.com/171004063

For example, for a new WordPress installation, you can visit
yoursite.com/wp-login.php or yoursite.com/wp-admin to login. It might be helpful if
you bookmark your site’s login URL. From your WordPress login screen, you'll enter
the username and password that you set up during the WordPress installation
process. If you've forgotten your WordPress login password, you can click the “Lost

Your password?” link to retrieve it via email.



Exploring the WordPress Dashboard

Once you’ve logged in to your WordPress site, you'll land here, the WordPress

dashboard.

#& Mywpsite B 4 New

ﬂ Dashboard Dashboard

Home

WordPress!
ed some links to get yi

Get Started

Customise Your Site

Watch the video: Exploring the WordPress Dashboard

Exploring the WordPress Dashboard

The WordPress dashboard allows you to control all of the behind-the-scene details
of managing your site. Once you find your way around the dashboard, you'll realize
it's

really easy to use and navigate.

First, we'll take a look at the dashboard home screen. After you first log in, you'll see
a top Welcome to WordPress section with some quick links to help you get started.

You can always dismiss this box using the link in the top right corner.

The next section is the At a Glance section. Here you'll see the number of posts and
pages for your site’s content. You'll also see discussion information for comments,

like the total number of comments and the number in moderation. In the At a Glance

%}@


https://vimeo.com/171004062

section, you'll also see what WordPress theme you're currently running on your site

plus your current version of WordPress.

The Activity section shows recently-published posts, pingbacks and recent
comments. From here, you can quickly approve comments, reply back, mark as

spam or send to trash.

If you scroll back up to the second column, you'll find the Quick Draft section of the
WordPress dashboard.

QuickPress will allow you to save a draft of a post straight from this screen. Below
this section, you'll see a list of other post drafts. Once you start creating posts and if
they’re saved as drafts, the three most recent drafts you've started will be visible

here.

The last section is the WordPress News section. These are updates from the official
WordPress project. If you'd like to customize what sections you see from the

WordPress dashboard, visit the Screen Options tab on the top right side of your
screen. Click the arrow to expand this section and you’ll see checkboxes for each of
the sections usually included in the WordPress dashboard. To remove any of the
sections, just unclick the checkbox beside the section you'd like to hide. You can

also choose the number of columns for the screen layout, too.

If you return to the dashboard home, you can also expand each of the sections by
clicking the arrow to the right. You can also drag and drop the boxes to change the
Order.

Left-hand Navigation Menu

In addition to the WordPress dashboard home screen, the other major component of
the WordPress dashboard is the left-hand navigation menu. This navigation menu
provides links to all of the WordPress administration screens for posts, the media

library, pages, comments, appearance options, plugins, users, tools and settings.
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We’'ll explore the rest of these menu items in more detail in the upcoming chapters.

If you ever find yourself needing help, just click the Help tab in the upper corner.

Click the arrow to expand and you’ll now see helpful information that walks through

the overview, navigation, layout and content of the WordPress dashboard.



Using the WordPress Admin Bar

The WordPress admin bar is simply a shortcut area that allows you to access site

management controls on the front end of your WordPress blog or website.

& My WP Site

Watch the video: Using the WordPress Admin Bar

The WordPress admin bar appears above your site if you are logged in to your
WordPress dashboard. This is to allow for easy editing and site management directly
from your site without having to jump back and forth between the front end (what
visitors see of your site) and the backend (your WordPress dashboard). It provides
some handy shortcuts to access parts of your WordPress installation without having

to find them in the left-hand navigation menu.

Quick Note: Visitors to your site will not be able to see this admin bar because they

are not logged in to your WordPress dashboard.
Once you've logged in to your site, locate the top bar on the top of your screen.

On the far left side of the WordPress admin bar, you'll see the WordPress logo. If

you hover over this logo, you'll see links to WordPress-specific information. These
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https://vimeo.com/170999141

are great quick-links if you ever need to take a look at WordPress documentation,

visit the support forums or leave feedback.

To the right of the WordPress logo, you’ll see the name of your site. Hover over this
and you’ll see a submenu to visit the front end of your site. This is how your site

looks to visitors.
The next section gives a quick reference for comments.

The last section on the left side of the admin bar is the + New link. If you hover over
this link, you'll see a submenu that will quickly take you to the add new screen for
post, media, page and user. All of these things can also be done from the left-hand
navigation menu of the dashboard, but this link is great for getting these tasks

done quickly.

On the far right side of the screen, you'll see “Howdy, your name.” Hover over this

section to see the submenu to edit your profile or log out of the site.

The WordPress Admin Bar Front End View

By default, once you've logged into your WordPress site, the admin bar will also be
visible to you from the front end of your site. If you hover over the name of our site,

then click visit site, you’ll see the front end of your site.
From this view, the WordPress admin bar changes a bit.

By hovering over the title of your site, you’ll see links for the dashboard, which will
take you back to the dashboard home, and links to take you to themes, customize,
widgets, menus, background and header. Again, all of these sections can also be
found from the left-hand navigation menu in the WordPress dashboard, but this is

a great quick reference.
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This view also adds a search function. Click the magnifying glass to open the search

prompt.

How to Turn Off the WordPress Admin Bar

Most people find the WordPress admin toolbar useful, but some people may want to
turn the WordPress admin bar off from the front end of the site. Remember, the

WordPress admin bar is only visible to you when you’re logged in to your site.

To turn off this view, click the Edit my Profile link. Now, from this screen, you’ll see
a check box to Show Toolbar when viewing site. Simply uncheck this box to turn
this

view off, then scroll to the bottom and click Update profile.
If you return to the front end of your site, the WordPress admin bar will be no longer

visible. If you decide later that you'd like to turn the admin bar back on, just return to

your edit profile and check the box to show the toolbar again.
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Exploring WordPress Settings

WordPress Settings offer many options for customizing your WordPress site.

General Settings

Site Title
Tagline er WordPress site

rds, explain what this site is
WordPress Address (URL) http://localhost/wordpress

Watch the video: Exploring WordPress Settings

Exploring WordPress Settings

From the WordPress dashboard, locate the Settings menu. If we hover over this

menu, you'll see a submenu appear with options for various WordPress settings

including:

e General

e \Writing

e Reading

e Discussion
e Media

e Permalinks
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https://vimeo.com/171004065

WordPress General Settings

To get started, expand the WordPress settings menu. Click General Settings.

The first thing you’ll notice in General Settings is your Site Title and Tagline. You'll
want to make sure these titles match your site because your site title will be visible in
Google search results. By default, WordPress includes “just another WordPress site”
as your site’s tagline. You'll probably want to update this tagline to be descriptive of

your site, because the site tagline will also show up in Google search results for your

site.

The next section is the WordPress Address (URL). For the site address URL, you
can enter the URL address if you want your site homepage to be different from the
directory where you installed WordPress. In most cases, it's best to leave these two

URLSs alone.

Next you'll see the E-mail Address that’'s used for admin purposes, like new user

notifications.

Next are settings for Membership. With WordPress, you can allow anyone to

register for your site.

The New User Default Role is by default set to subscriber. You'll probably want to
leave this setting, since you don’t want to grant administrative privileges to just

anyone that registers for your site.

Next is Timezone. Scroll through the list to select the city in the same timezone as
you then select your preferred date format. Keep in mind this date format will be
visible on blog posts. If you have any questions about this format, you can check out

the documentation on date and time formatting by clicking the link below this section.

12
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The next three areas, Date Format, Time Format and Week Starts On, allow you

to customize your date and time settings.
Last is Site Language. You can select your language from the dropdown list.

Once you've updated or change these settings, click Save changes.

WordPress Writing Settings

Next up are Writing Settings. From the left-hand navigation menu, click to open the

Writing Settings page.

All of the settings on this page apply to writing and publishing content for your site.
The top section controls the editor within the WordPress dashboard, while the rest

control external publishing methods.

We will only focus the first section, you'll see options for formatting, including settings
for default post category and default post format. When you make your selection in
these dropdowns, new posts will automatically have the selected category or post
format applied. Post formats are simply a way WordPress can format your posts,
depending on if your theme provides styling for that particular format. We'll cover

more on categories in a later chapter.

WordPress Reading Settings

Now it's time for Reading Settings. This screen contains the settings that affect the

display of your site’s content.

From here, you can choose what the front page displays, either your latest posts or
a fixed/static page. Once you've created a few pages, those pages will be listed in

the dropdown as options for your front page and where to display your posts.

13
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In the next section, you can set the number of pages your blog pages show at
most. This setting will limit the number of posts shown on a single page of your blog,

before a user has to use a “previous” or “next” link to see more posts.

The next section is where you can control the display of your content in RSS feeds,
including the number of recent items syndication feeds show and whether to show

full text or a summary.

The last section is for search engine visibility. If you'd like search engines to ignore
your site, click the checkbox next to Discourage search engines from indexing
this site. This might be a helpful setting if you're currently developing your site and

you’re not ready for it to be indexed by search engines.

Click the Save Changes at the bottom of the screen to update these changes.

WordPress Discussion Settings

WordPress Discussion Settings provide a ton of options for the management of

comments and controlling links to your posts/pages.

The first section is for default article settings. The first setting deals with links you
make to other blogs. The second deals with pingbacks and trackbacks, or links back
to your blog. The third setting is the default article settings that allow people to post
comments on new articles. If you'd rather not allow people to comment on your

posts, uncheck this box.

In Other comment settings, you can choose the guidelines for how people post

comments and how their comments are handled.

Next, in the email me whenever section, you can choose to be emailed when

someone posts a comment or when a comment is held in moderation.

14
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The Before a comment appears section deals with how comments are published.
Here you can choose if an administrator must always approve comments or to

publish automatically if the comment author had previously posted a comment.

In the Comment Moderation area, you can customize how a comment is held
based on the number of links. In this box, you can also add words, names, URLS,

emails or even IPs to filter comments into the moderation queue.

Both this section and the comment blacklist section are great for helping to defend

your blog against spam comments.

Next, take a look at the avatar section. An avatar is a profile image you can have
assigned to your email address when you comment on avatar-enabled sites.

Here you can enable the display of avatars for people who comment on your site,
filter by their rating or chose a default avatar for people that don’t already have a

custom one of their own.
Click the Save Changes button at the bottom of this page.

WordPress Media Settings

The Media Settings page allows you to set maximum sizes for images inserted into
the content of a post. These settings are great for saving time if you always want
images to be the same size or if you want to apply default settings for medium and

large image sizes.

The Uploading files option allows you to select whether or not your uploads are

organized into month and year based folder.

Click Save changes.

15
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WordPress Permalink Settings

Permalinks are the permanent URLs to individual pages and blog posts, as well as

category and tag archives.

Basically, a permalink is the web address used to link to your content that is

permanent, and never changes - that’'s why they’re called “perma”-links.

The WordPress Permalink Settings screen allows you to choose your default
permalink structure. You can choose from common settings or create custom URL

structures.

By default, WordPress uses web URLs, which have question marks and lots of
numbers in them. You'll probably want to change your permalinks here to another
structure to improve the aesthetics, usability, and forward-compatibility of your links,

and to make them more search engine-friendly.
If you’'d like more information on setting up your permalinks, click the Help tab at the

top of the screen. Here’ you’ll get an overview of common settings and structures to

help select your permalink structure.

16



WordPress Posts vs. Pages

When it comes to creating content for your WordPress site, you have the option to
choose between creating either a post or page. Both have their respective uses and

can add dynamic elements to your site.

POStS  Add New Pages AddNew

All (1) | Published (1) 1) | Published (1)

Bulk Actions ¥ || Ap ctions ¥ || Apply All

] Title itle

Hello world! ample Page

] Title [ Title
Watch the video: WordPress Posts vs. Pages

Posts vs. Pages

A WordPress post is what makes up the ‘blog’ aspect of your site.

e These are generally news or informational updates about a certain topic.

e Posts are listed in reverse chronological order and can be tagged, categorized
and even archived on your site.

e \WordPress posts are what make up the RSS content of your WordPress blog.
So, when someone subscribes to your RSS feed, your posts will be the
content that’s delivered to them.

e Think of the posts as the news portion of your site. They’re dynamic and

constantly changing the content your end users see.
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https://vimeo.com/171022855

WordPress Pages are similar to posts in that they have a title and body text, but

they are different because:

e They are generally reserved for static content or information.

e Examples of this would be an About Me or Contact Us page.

e Pages aren't listed by date and can’t be categorized or tagged like WordPress
posts.

e Pages can have a hierarchy, which means you can nest pages under other
pages by making one the “Parent” of the other, thus creating a group of
pages.

e Due to their static nature, pages aren’t included in RSS feeds and won'’t have

date or time publishing.

Using Posts & Pages

Generally posts will be used for your blog content and pages will be used for
standalone information that isn’t updated often. For example, an organization might
use posts to handle news updates, press releases, job listings or new products. But
they’'d use pages to list “about” information, services, contact info, team bios,

locations or by laws.

WordPress is flexible and you can use posts and pages however you want, but this

gives you a basic overview of how they work.
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Creating a WordPress Post

To get started creating your first WordPress post, locate the Posts menu in the
left-hand side of the WordPress dashboard. You can either hover over the Posts link

or click to expand it to reveal the submenu.

Add a New Post

Enter title her

03 Add Media
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Watch the video: Creating a WordPress Post

The Add New Posts page can also be found from the + New link in the WordPress
Admin Bar.

Click the Add New link.

Now you’ll see the Add New Post page where you can create your first post.

The first box is where you’ll want to enter the title of your post.

Next is the post formatting section or post editor. This is where you’ll actually type
the content of your post.

If you look on the right side of the box, you’ll see two tabs. There are two modes of

editing posts: Visual and Text.

ggﬁ@,
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https://vimeo.com/171021907

The Visual tab will bring up the visual WYSIWYG editor. WYSIWYG just means
‘what you see is what you get.” Here you'll see a formatting toolbar with lots of
options for formatting your posts. If you're familiar with Microsoft Word or any other

word processing software, most of these icons should look familiar.

If you click the Text tab, this will reveal a plain-text HTML version of the post editor.
This version of the post editor is for editing the HTML code of your post. For most

users, the Visual editor is the easiest way to write posts.

At the top of the right column on this screen you’ll see the Publish box. Here, your
can save your post as a draft if you’d like to save it for later. If you click the Preview

button, you can get a preview of how the post will look once it’s published.

The Status of the post will show if the post has been published, saved as a draft, if

it's pending review or if it has been scheduled.

The next two links show the visibility of the post — or what visitors will be able to see
your post. The Publish line shows whether the post will be published immediately or

at a later date.

The next section are for categories and tags assigned to your WordPress post.

We’'ll cover these two topics in more detail later.

If you'd like to change the screen options for your post editor, just click the screen
options tab in the upper right hand corner. Expand this to reveal all the options that

can be displayed on the post editor screen.

Again from the post editor, you can also drag or drop the order of these boxes to

customize how you want them arranged on the page.

20
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If you ever need help while you’re on the Add New Posts page, just click the Help

tab in the upper right corner.

From here, you'll be able to get a reminder for how to customize your post display,
tips for adding a post title and using the post editor, inserting media and settings

for publishing and discussion.
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Adding Links in WordPress

The WordPress post and page editor makes it easy to add hyperlinks to other web

pages from your content.

Insert/edit link X
Enter the destinotion URL
URL |

Link Text

Open

Or link to existing conteint

Search

No search term specified. Showing recent items.
Sample Page PAGE

Watch the video: Adding Links in WordPress

Adding Links in WordPress

1. From the WordPress post or page editor, select the text that you want to be
hyperlinked.

2. Once you have that text selected, click the hyperlink button in the toolbar.

3. This will bring up a box where you can enter the URL of your hyperlink and a
title to be displayed on hover. You can also click this checkbox to open the
link in a new tab.

4. If you'd rather link to existing content on your website, just click to expand this
section. Now you’ll see a search bar to search your site and a list of existing
posts or pages. Clicking on one of the items in the list will change the
hyperlink URL above.

5. Once you have your hyperlink URL ready to go, click the Add Link button.

Now your selected text will have a link.
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6. To remove the link, select your text again and click the unlink button. Now

you’ll see that your link has been removed.
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Adding Images to Posts & Pages

Using a visual element like an image or photo is a great way to emphasis your post

or page content.

03 Add Media
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Watch the video: Adding Images in WordPress

1. Determine where you'd like to insert your image in your post or page. Above
the Post editor toolbar, you’ll see an Add Media button. Click the Add Media
button and you’ll see the Insert Media box.

2. Your WordPress site uses a media library to store all of your media like
images and videos. From this box, you can choose to either upload a new file
or use an existing file from the media library. To upload an image, click the
Select files button. Find the image you’d like to use and click open.

3. Now that your image has been uploaded, you'll see it has been added to the
media library. On the right side of this box, you’ll see the attachment details
for this page. Here you can change the Title, Caption, Alt text and
Description. You can also choose the alignment of the image (such as
center, left or right), where the inserted image should link to, the actual URL

of the image and the size of the image.
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4,

Make sure the image has a checkbox and click the Insert into post button.
Now you’ll see your image has been added to your post.

If you click on this image, you should see two boxes appear in the upper
left-hand corner of the image. The first is the image icon. If you click that icon,
you’ll now see another box open for editing the details of the image. Here you
can change the size of the image based on percentages (which can be a
handy tool for resizing) or you can update the title, alternative text, the caption
and link URL. You can also select this image to link nowhere, or to link to the
actual image file.

If you click the advanced settings tab, you’ll see the URL of where the image
file is hosted on your site, the actual width and height of the image in pixels,
the CSS Class, styles and image properties that add padding around the
image.

Return to the image in your post. The next icon in the upper left corner will
delete the image out of the post. If you click the Add Media button again,
you’ll see the same insert media box. On the left side of this box, you’ll see
options to create a gallery and set the featured image. Once you have more
images in our media library, you'll be able to add an entire gallery of images

into the post.

The featured image of the post is sometimes used by your WordPress theme. Go

ahead and choose this image as your featured image and return back to the post

editor. Now, you can preview the post and see that our image has been added.
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Using the WordPress Media Library

The WordPress Media Library contains all the files you've uploaded to your

WordPress site, with the most recent uploads listed first.

& Mywpsite BB 4+ New

# Dashboard Media |_|brar'y Add New

™ Posts
iaitems v | Alldates ¥

Q7 Media

Library

.I:'._ |:| .'j i.] 2w

Pages

Watch the video: Using the WordPress Media Library

Using the WordPress Media Library

To visit your WordPress Media Library, expand the Media menu from the
WordPress dashboard. The Media Library page will show all of the media items you

currently have in your media library.

To add a new media item to your library, click the Add New link. From here, upload
a new image. Once your image has been uploaded, you'll see it has been added to

the library.
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Editing Images in the WordPress Media Library

One of the neat features of the WordPress media library is the ability to edit images.
Click on an image, and then click the Edit Image button. Now, you can crop, rotate,

flip or scale the image.

For example, you can rescale this image and then click the Save button. Now, click
the Update button.

WordPress Media Library Multi-File Uploader

If you have more than one file to upload at once, you can easily switch to the

multi-file uploader.

Now, just drag and drop multiple files here to be added to your WordPress Media

Library.
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Formatting WordPress Posts

In this section, we’ll be covering some of the basics of formatting your WordPress

posts with the built-in WordPress post editor.

03 Add Media
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Paragraph

Paragraph

Heading

Heading 2

Headino 2

Watch the video: Formatting WordPress Posts

The majority of your formatting options can be found in the Post Editor Toolbar. If
you’ve ever used a word processing software such as Microsoft Word, most of these

icons should look familiar.

To get started formatting your WordPress posts, visit Posts > Add New or Posts >

All Posts and select the post you'd like to edit.
The formatting icons included in the WordPress post editor include:

e In the first row of the toolbar, we have options to bold, italicize or
strikethrough text. To bold text, just select the text you'd like to format and
click the bold button. You'll see this text has been bolded.

e The next two icons are for bulleted and numbered lists. If you'd like to add a

list to a post, just select the text, then click that icon.

%@@)
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The quotation mark icon is the block quote feature. By default, this will add
an indentation and italicized style to your selected text. (Note: your
WordPress theme controls how block quotes are styled on the front end of
your site.)

Next are alignment options. You can choose to align left, center or align
right.

The next icon is the insert more tag. This will change how much text your
blog page displays with a read more link.

If you'd prefer to write your posts in distraction free mode, click this icon.
This will take you to full-screen writing mode similar to using a Word
processing software. To exit out of this mode, we’ll click “exit fullscreen.”

If we click the Show/hide the kitchen sink, another line of formatting options
will be revealed. Here you can add heading styles to your text, underline
text or set a full alignment.

If you decide you’d like to change the color of your selected text, just use this
icon to select the color.

The next two icons are for pasting text - either as plain text or from
Microsoft Word.

If you ever get stuck using your formatting icons, you can simply hover over the icon

to see the name and function.
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Scheduling WordPress Posts

Scheduling your WordPress posts is an easy way to control when your content is

published. With the built-in WordPress post scheduler, you can add a time to publish.

Publish i

Preview Changes

Visual Text
oK | Cancel

(@] Public
[ ] stick this post to the front page
Password protected
Private

Watch the video: Scheduling WordPress Posts

Scheduling WordPress Posts

This WordPress posts scheduling feature is found in the Publish box on the upper

right side of the post editor page.

To schedule a post for publication, click the edit link next to Publish Immediately.

You’'ll now see a drop-down option to select the month, date and year to publish

the post, even the exact hour and minute.

For example, if you'd like to publish this post at 8 a.m. tomorrow, select tomorrow’s

date, set the time for 8 a.m., and click Ok. You’'ll now see the Schedule button has

Appeared.

ggﬁ@,
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Click the Schedule button and you'll see the status of this post has changed to

scheduled with details for the exact date and time it will be published to your blog.
If you change your mind and want to publish this post immediately, click the Edit link

next to the scheduled publish time. Just update the time to today’s date and the

current time and this will immediately publish the post.
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WordPress Categories & Tags

WordPress categories and tags are a way to add an organizational structure to your

WordPress posts.

Categories
Add New Category Bulk Actions * | Apr
Mame MName

[

The name is how it appears on

Uncategorised

Mame
Slug

Bulk Actions ~ ARE

The “slug= is the URL-friendly version of the name. It is usually all

lowercose ond contains only letters, numbers, and hyphens. Note:

Neletine o rodfeenne Anec 1

Watch the video: Categories & Tags

WordPress Categories

WordPress categories are basic ways for you to organize your posts into different

categories, such as topics.
For example, when writing a post, think of the wider topic of the post. If you plan to
write more posts about this topic in the future, you’ll probably want to group these

posts together.

From the post editor page, find the Categories box.

ggﬁ@)
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Adding a New Category

If you don’t have any categories yet, click the + Add new category link. Add a new
category and click Add new category. You'll then see your new category has been

added to the list of categories
To assign a category to a post, click the checkbox next to the category.

Another way to manage post categories is through the Posts > Categories link in
the WordPress dashboard navigation menu. Clicking the Categories link will display
the Categories page. From here, you can see all your categories on the right, and

where to add new ones.

Category Slug

The Category Slug is the URL-friendly version of the category. It is usually all

lowercase and contains only letters, numbers and hyphens.

Category Hierarchies

Categories, unlike tags, can be nested into hierarchies.
For example, you might have a Jazz category, and under that have children

categories for Bebop and big band.

Category Description

The description section is a place for you to add more details about the posts

assigned to that category. Some WordPress themes may show this information.
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WordPress Categories vs. Tags

What's the difference between categories and tags? Think of your site like a book.

Categories are like the Table of Contents and tags are like the terms in the index.
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Creating a WordPress Page

Creating a WordPress page is very similar to creating a post. Just remember that

pages are intended for static content.

#% Dashboard Ad d N ew Page

055 ere

B Media

M Pages

Add New B I #== = = (& —

i
b
a4
m I
N

- Paragraph + U
Comments Erap

Watch the video: Creating a WordPress Page

Creating a WordPress Page

1. To get started adding a new page to your WordPress site, find the Pages
menu in the WordPress Dashboard Navigation menu. Click Add new.
The WordPress page editor looks nearly identical to the post editor, except for
a few different boxes located on the right side of the screen.

2. Add the title of the page, like About.
Note: If you have pretty permalinks set up, the title of your page will also be
the URL slug.

3. Next, add some content.

4. The Publish section of the page editor is exactly the same as for writing
posts. When you’re ready to publish, you can either publish immediately, save

this as a draft, or schedule the page to be published later.
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The Page Attributes section applies a parent page and template to your new
page. For the Parent section, you can arrange your pages into hierarchies.
For example, you could create this new page with additional pages under it.
There are no limits to how many levels you can nest pages.

Some WordPress themes have custom page templates, so the next Template
section allows you to apply a template to your new page.

The Order box allows you to order your page numerically. Pages are usually
ordered alphabetically, but you can choose your own order by entering a
number in this field.

Preview the page one last time, then click Publish. You've added a new page

to your WordPress site.
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Applying a WordPress Page Template

Some WordPress themes include page templates that change the way your pages

are formatted on the front end of the site. By using page templates, your theme

changes how your pages look and where certain page elements are located.

Page Attributes 4

Template
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p

Meed help? Use the Help tab in the upper
right of your screen.

Watch the video: Applying a WordPress Page Template

Applying a WordPress Page Template

1. To add a WordPress page template to a page, edit or add a new page from

the Pages menu located in the WordPress Dashboard.

Find the Page Attributes section. In this section, you’'ll see a drop-down list

for available page templates.

2. Depending on your WordPress theme, you’ll see your specific page template

options in the drop-down menu.

For example, for this WordPress theme, you have an option to select the

Default template, a Front page template or a Full-width page template with no

sidebar.
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Previewing your WordPress Page Template

To test out how each of these templates would change the look of the page, select a
page template. Now, you can preview the changes to this page and decide whether

or not to apply this page template to the page.

Publishing the Page

Once you've selected the page template to apply, just make sure it's been selected

and click Publish.
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What are WordPress Plugins?

WordPress plugins are bits of software that can be uploaded to extend and expand

the functionality of your WordPress site.
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Watch the video: What are WordPress Plugins?

Note: One of the primary advantages of using the self-hosted version of WordPress from

WordPress.org is the ability to upload and use plugins on your WordPress site.

Since WordPress is open source software, these are all third party tools that add-on
to what WordPress can do. They're easy to download and install. Some are premium

(there is a fee to purchase them) and others are free.

Plugins can do things like improve your search engine optimization, display related
posts in your sidebar, do complete backups of your WordPress site or create web
forms quickly and easily.

You can add just about any functionality to WordPress with plugins. There are
currently more than 40,000 plugins in the WordPress directory, so there are a lot of

options.
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39


https://vimeo.com/171019498

Installing WordPress Plugins

Installing plugins on your WordPress site is a simple process.
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Watch the video: Installing WordPress Plugins
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Download & Upload Method

Note: If you're using premium plugins from a third party source, they will usually come as a

.zip file. You'll need to use the download & upload method to install the plugin zip file on your

site.

1. To install a plugin on your WordPress site, locate the Plugins menu after

logging in to your site’s WordPress dashboard. Expand this menu.

2. To upload a new plugin, click the Add New link.

3. Click the Upload Plugin button, locate your plugin zip file and then click

Install Now. Then, click Activate.
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Search & Install Method

You also have the option to search for plugins to install from the WordPress.org
Plugin Directory, directly from the Add New Plugin. Click the tabs on this page to

see featured, popular, newest and plugins you’ve marked as favorites.

1. Use the search bar to search for the plugin of your choice.
2. Click the Install Now button.

3. Once the plugin is installed, just click Activate.

Manual Installation Method

You can also add plugins manually by uploading them with FTP software. This is
more complicated and not for the novice user. You'll need to download the plugin file

to your computer and unzip it.

This will give you a folder on your computer with all the plugin files. Then, using an

FTP program, upload the plugin folder to the wp-content/plugins folder on your site.

Then go to the Plugins screen and you can find your new plugin in the list. Click

Activate to get started.

More Plugins Menu Options

On the Installed Plugins page, you'll also see a list of all the plugins currently

installed on your WordPress site.

Some plugins come bundled with your WordPress installation, like Akismet, a plugin

that protects your blog from comment and trackback spam.

The last menu item beneath Plugins in the WordPress dashboard is the Editor. The

built-in WordPress plugin editor can be used to make changes to any of your

%}@
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plugins’ individual PHP files. Just be aware that if you make changes, plugin updates
will overwrite your customizations. So, unless you know PHP, you probably won’t

want to edit any of your plugin’s PHP code.

42



What is a WordPress Theme?

A WordPress theme provides all of the front end styling of your WordPress site.

Themes e Add New Search installed themes...

Twenty Slxtesn

i Dok Tl e o 20

Come Sail Away with

Inchvidually, we are co= doop. Logether)

Sneraudep (he ragh i Fre dusr fre e B Bl e Asse 1he g
2w az wwee D21 gy beeene al e

rerierbar avd o
e fta 1he e dmarmeanrggartk e thade b o e e e
Sz

- s iz |

Watch the video: What is a WordPress Theme?

WordPress uses themes to control the look and presentation of your site. You can
quickly change themes and change the entire look of your site, while still maintaining

the underlying WordPress software that powers your site.

WordPress themes are kind of like how a new outfit can give you an entirely new
look. But themes go even deeper than just the design. They control the layout and
functionality of your site as well. You can create different layouts for different types of

content with a theme.

You can change the entire look of your site without ever changing the content or
backend structure. A few clicks of the mouse and you can add a new theme and
have an entirely new look. It can make updating your site and keeping things current

a much quicker and simpler process

%@,
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Themes come in all types and varieties, including free and premium themes. You

can also customize a theme to make it your own.

Most WordPress themes provide:

e The overall design or style of your site
e Font styling

e Colors

e \Widget locations

e Page layouts (or templates)

e Styles for blog posts and blog archives

e Additional stylistic details

Important note: Keep in mind that we are only talking about existing (free and
premium) themes, custom developed themes can have added functionalities,
features and custom code, meaning that switching to a different theme, there can be
some functionalities that can stop working properly or simply won’t appear on that

new installed theme.
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How to Install a WordPress Theme

In addition to the default theme included with your WordPress installation, you can

also install your own WordPress theme to change the look and style of your site.
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Watch the video: How to Install a WordPress Theme

Download & Upload Method

From the WordPress dashboard, expand the Appearance menu in the
left-hand navigation panel. Click the Themes link.

Click the Add New button.

Click the Upload Theme button, locate your theme zip file and then click

Install Now. Then, click Activate.

Search & Install Method

Much like installing plugins, you can search for a free theme and install it directly

from your WordPress dashboard.
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1.

From the Appearance > Themes page, click on the Add New button. You
can search the Free Theme Directory right from your WordPress dashboard.
Find a theme you like (you can use the search box or the feature filter to sort
by various options)

Once you find a theme you like, click Install. Once the theme is installed, just

click the Activate button. And just like that, your site has a brand new look.

Manual Method

You can also add themes by manually uploading them to your server with FTP

software. This is more complicated and not for the novice user.

You'll need to download a theme to your computer and unzip it. This will give you a

folder on your computer with all the theme files. Then, using an FTP program, upload

the theme folder to the wp-content/themes folder on your site.

Then go to the Themes screen in your dashboard and you will see your new theme

in the list.

Click Activate to get started.

Managing Your WordPress Themes

1.

To manage your WordPress themes, expand the Appearance menu in the
WordPress Dashboard.

Here, you'll see the Themes page.

The very first theme listed on this page is your Active theme. Here we also
see an option to Customize. If you click this button, you’ll see a preview
window that allows you to make stylistic changes to your site, such as your
Site Identity (Site Title, Tagline & Site Icon). From here, you can also make

changes to Menus and the Front Page.
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If you return back to the Themes page, you'll see a grid list of available
themes in addition to your active theme. These are themes that have been
also installed on your WordPress site, but aren’t active.

In the left-hand panel of the preview window, you can edit the theme settings.
These settings will differ, depending on what theme features the theme
supports.

To accept the new settings and activate the theme all in one step, click the

Save & Activate button at the top of the left-hand panel.
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Using WordPress Widgets

WordPress Widgets add additional content and features to your WordPress site.
Examples of widgets are search bars, a list of post categories or tags, and custom

menus.
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Watch the video: Using WordPress Widgets

WordPress widgets don’t require any code experience or expertise.lf the Theme we
have installed and active supports them, they can simply be added, removed and

rearranged.

The actual location of widgets on your site depends on your WordPress theme. Most
WordPress themes offer several different page templates that decide where widget
locations are in the page design, such as in the sidebar of your blog, or at the bottom

of your home page.

In addition to the default WordPress widgets, WordPress plugins often add their own

widgets as well. Some may add additional options for customization features.
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To see how widgets work, log in to your WordPress site and visit the Appearance >

Widgets panel. On the left side of the page, you'll see all available widgets.

Default widgets will be visible here, plus any additional widgets that have been
added by your installed plugins. On the right, you’ll see all of your available widget

locations.

To add a widget to a location, simply drag the widget from its place on the left into
the right section to activate them.

To remove them, simply drag the widget back or click delete.

If you ever have questions or need help using widgets, just click the Help tab from
the top of the screen. Here you'll find an overview, information on removing and
reusing widgets and how to handle missing widgets if you change your WordPress

theme.
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Creating a Custom Menu in WordPress

With WordPress, you can easily create a custom menu, which usually serves as a

navigation menu for your site.
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Watch the video: Creating a Custom Menu in WordPress

Custom menus in WordPress may contain links to pages, categories, custom links or
other content types. You can also specify a different navigation label for a menu item

as well as assign other attributes.

There’s no limit on how many menus you can create, so if your theme includes more
than one menu location, you can choose which custom menu to associate with each
location. You can also use custom menus in conjunction with the Custom Menus

widget.

How to Create a Custom Menu in WordPress

1. To get started creating a custom menu, log in to your WordPress site and
click to expand the Appearance menu on the left side of the WordPress
Dashboard.
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Click on the Menus link in the Appearance menu. You'll now see the Menus

editor page.

3. Enter your menu name, and click Create menu.

4. Now you're ready to add menu items from the boxes on the left, such as

pages, categories and links.

If you'd like to change which menu options you see from this page, click to
expand the Screen Options tab. Now you can add other menu items options
such as posts, tags or formats, or show advanced menu properties.

When you have your menu items arranged in order, click Save Menu. You
now have a new navigation menu that can be added to any menu location on

your WordPress site.
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Managing Comments in WordPress

By default WordPress has a comment system implemented, visitors can leave

comments on posts and pages, if we have it enabled.
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Watch the video: Managing Comments in WordPress

The Comments Page

Managing comments in WordPress is quite similar to the way posts and pages are

managed. From the WordPress dashboard, visit the Comments page.

A yellow row means the comment is waiting for you to moderate it. You can act on

comments using the onhover action links or the Bulk Actions.

In the Author column, in addition to the author's name, email address, and blog
URL, the commenter’s IP address is shown. Clicking on this link will show you all the

comments made from this IP address.
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In the Comment column, each comment includes Submitted on information,
followed by the date and time the comment was left on your site. Clicking the

date/time link will take you to that comment on your live site.

Hovering over any comment gives you options to approve, reply (and approve),

quick edit, edit, spam mark, or trash that comment.

In the In Response To column, there are three elements. The text is the name of

the post that comment is assigned to, and links to the post editor for that entry.

The View Post link leads back to that post on your live site. This small bubble with
the number shows the number of approved comments that post has received. If

the bubble is gray, you have moderated all comments for that post. If it is blue, there
are pending comments. Clicking the bubble will filter the comments screen to show

only comments on that post.

WordPress Comment Settings

Don’t forget you can change your Comment or Discussion settings from within the
WordPress settings menu. This page allows you to make changes to the details of
comments made on your site, plus the ability to blacklist comments to help manage

spam comments.
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Creating Users in WordPress

Creating users in WordPress allows you to add users with different roles and access

privileges to your site. Once created, a user will be able to log in to your site with a

username and password.
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Watch the video: Creating Users in WordPress

Change role to..

WordPress allows you to create users with specific roles. Different roles have

different responsibilities and powers within WordPress. This is important if you have

a team working on your site.

It allows you to have a process where only certain users can do specific tasks, such

as publish posts. It's a good way to ensure quality control, spread out responsibility

and keep everything in check.

WordPress user roles include site administrator, editor, author, contributor and

subscriber.
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Here’s an overview of the five different user roles in WordPress:

Administrator: Access to all administrative features. When you install and set
up WordPress you're automatically given an administrator account.

Editor: Can write, edit and publish posts and pages, as well as manage other
users’ posts.

Author: Can write and edit their own posts, as well as publish them.
Contributor: Can write and edit their own posts, but they can’t publish them.
Subscriber: Can only manage their own profile. This role is usually for
readers of your blog and makes commenting and interaction easier

(especially if you only allow registered users to comment).

Creating Users in WordPress

. To add a new user to your WordPress site, log in to your WordPress site and

click to expand the Users menu.

Click the Add New link located in the Users menu.

Enter the username, email address, first name, last name, website, and
password for the user.

If this user is brand new, it's a good idea to select to send this password to the
new user by email.

Next, select the subscriber role for the user.

To see a basic overview of WordPress user roles, click the Help tab at the top
of the screen. Here you’ll see details for how user roles relate to site
privileges, so you’ll be able to decide which level of access to grant to your

new user.

Editing Users

Once a user is created, you can mouse over their name in the Users list and an

Edit link will appear. Click the Edit link to access the Profile edit screen.
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There are a number of helpful options here, most self explanatory, but a few could

use some explanation:

Visual Editor: If you need people to enter HTML and not use the visual
editor, you can force them to use HTML by disabling the visual editor here.
Admin Color Scheme: Change up the default colors a user sees in their
WordPress dashboard.

Keyboard Shortcuts: Enable keyboard shortcuts for comment moderation.
Toolbar: This turns off the WordPress admin bar when that user is logged in.
Username: Note that the username cannot be changed.

First Name, Last Name & Nickname: These fields allow you to enter this
information for a user, so their first and last name can be used in blog post
authorship.

Display name publicly as: Once you enter a first name, last name and
nickname you’ll have several options in this dropdown. This determines how
WordPress will display this user's name.

Biographical Info: This bio paragraph can be optionally displayed,
depending on your theme. This can help you quickly and easily create author

pages for your blog team.

Important note: Do not create a user named admin. This is one of the easiest ways

hackers find their way into your site.

By default Wordpress on installation will create the username admin, if this field is
not filled.

So if this username i already set, all you have to do is then create another user as an

administrator, with a different username. You can then log in as the new

administrator and delete the old admin user account from the User panel.
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